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©Copyright 2018 by Actall Corporation®. All rights reserved. Crisis 
Controller©™ is a registered trademark of Actall Corporation. (U.S. 
Patent No.: 5,708,417) MicrosoftP®P and WindowsP®P are registered 
trademarks of MicrosoftP®P Corporation. Crisis Controller©™P Version 
5.00 software and documentation developed by Actall Corporation®, 
Denver, Colorado. (TUwww.actall.comUT) This manual is subject to 
change and may not be reproduced in any way or form, electronic or 
mechanical.

Software License Agreement: 
The use of this software product is limited to the terms and conditions 
below. Use by the purchaser of Crisis Controller©™ Alarm Monitoring 
software indicates acceptance of these terms.

Grant of Rights: 
This software may only be used on the computers for which it is licensed. 
This license may not be transferred from its original site. You may not 
copy or otherwise distribute this software, except to make a backup 
copy. You may not modify, alter, or transfer the software in any way.

Limitation of Liability: 
Licensor shall not be liable for any claim or demand by Licensee for 
damages of any kind, including, but not limited to special, general, 
incidental, direct or consequential dam-ages, for loss of business 
profits, business interruption, loss of business information, or any other 
pecuniary loss arising out of the subject matter of this agreement Some 
jurisdictions do not allow excluding or limiting implied warranties or 
limiting liability or consequential damages, and some jurisdictions have 
special statutory consumer protection provisions that may supersede 
this limitation. As a result, this limitation of liability may not apply to you 
if prohibited by the laws of your jurisdiction.

General: 
Any violation of this Agreement is subject to criminal and civil prosecution. 
If any provision is found to be unlawful, void, or unenforceable, then that 
provision shall be severed from this Agreement and will not affect the 
validity and enforceability of any of the remaining provisions. The laws of 
the State of Colorado shall govern this Agreement.

COPYRIGHT & LIMITATIONS CONTACT

Inquiries should be 
directed to:

Actall Corporation 
2017 Curtis St. 
Denver, CO 80205

Phone: 
303-226-4799
Toll-free:
1-800-598-1745

For technical support, 
please call us direct 
during regular 
business hours 
(Monday through 
Friday, 8:00 a.m. to 
5:00 p.m. Mountain 
Standard Time) or 
Emai us 24/7.

303-226-4799
support@actall.com
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SOFTWARE REGISTRATION CARD MUST BE FILLED OUT

Please fill out and return the Software Registration Card.

Actall® Technical Support needs the information on this card to verify authenticity of requests for service and to be able to 
provide timely and accurate technical assistance to our customers.

In addition, it is in the customer’s interest for Actall® to have a duplicate record of software serial numbers and Hardware 
Key codes. It also protects the customer if questions of software licensing arise. Additional information, such as computer 
type, operating system, and general application information can save a great deal of valuable time in troubleshooting and 
responding to customer needs.

Please note that factory passwords for the Supervisor, Operator, and Admin are shown on the initial password 
screen for the purpose of system setup only. For proper security, passwords should be immediately changed. 
If a hard copy is necessary for future reference it should be stored in a secure location.

Important!

Password Safeguard Warning!
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After logging into Crisis Controller, the Main menu option will be available. The drop down menus are as follows:

Not all Menu options are available for all attend levels

File: 

HDT: 

Devices: 

Admin: 

Tools: 

Monitor: 

Report:  

Window: 

Help: 

Login-  Change the current user.
Exit - Exit the system (Actall Special user and password need to exit the 
system).

Access to ATLAS transmitters, LDNs and related options.

Access to Stations, MGEs and outside hardware interfaces.

Access to HDT assignment menus.

Access to Map and Mapping functions as well as other system options.

Start and stop alarm monitoring mode.

Access to system reports.

Allows the user to arrange the open windows

Access to the Help file and Crisis Controller version information.

Crisis Controller Main Screen

Main Menu Options
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Crisis Controller Main Screen (continued)

There are five windows on the status bar that contain information. From left to right they are

If the Crisis Controller system is operating in as a network version, the software will monitor the network and 
database connectivity. In the event Primary database connection fails the system will display a warning screen 
stating the database is no longer found. The system will then look for the backup database (located on any computer 
running Crisis Controller). If the backup database can not be located the system will revert to it’s local backup copy 
of the database. When the fault is corrected the system can than be reconnect to the primary database.

1 Data Server currently connected

2 Current attendant logged into Crisis Controller

3 Current database
If you mouse over the window the path of the database will be shown.
There are three possible database that may be shown

These files should be only configured by Actall Corp the support. Changes in these files may cause the 
 system to not function correctly.

1) Primary Database (for networked system only)
This database is the network database configured in the (Actall.CrisisController.FormsUI.exe.config) file.

2) Backup Database (for networked system only)
This database is the network backup database configured in the (Actall.CrisisController.FormsUI.exe.
config) file.

3) Local Database (stand alone and network versions)
This database is the database configured in the (Actall.CrisisController.FormsUI.exe.config) file.

4 Current system date.

5 Current system time.

Status Bar Windows (bottom of the screen)

More on Database Use

Crisis Controller—ATLAS System User Manual
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Attendants

Admin attendants 

These attendants can only assign or de-assign HDT and print reports. All other functions are inaccessible

Operator attendants 

These attendants can only do alarm monitoring. Operators can not stop Alarm Monitoring or exit the  
system.

Tools > Attendants 

Attendants operate and control all 
functions of the Crisis Controller software. 
Users are entered into Crisis Controller at 
Admin, Operator, and Supervisor levels.

Passwords are never displayed in plain text, so lost passwords must be deleted and new ones 
assigned. To change passwords, highlight the desired user and press Edit Button, then enter a  
new password.

Add Button   Use this button to add in a new attendant.

Edit Button   Use this button to edit and exciting attendant.

Delete Button Use this button to delete a attendant from the system.

Attendant types
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Attendants (continued)

Under alarm monitoring mode there are access rights that can be assigned.

Tabs Access:  View Status and System Message tabs

Toggle Groups: Enable and disable Transmitter Groups and start and top the Guard Tour option.

Time Mode:  Change the Time Mode (Day, Evening and Night).

Simple Acknowledge/Reset: Setting this option does not show the Action Taken/ Notes window.

Supervisor Attendants

Users set at this level have full access to all system options. They can start and stop Alarm Monitor-ing as well as 
perform system configuration.

When adding attendants the following information is required:

Name: Attendants login name (ex: Sgt.Smith)

Password: Attendants password. 
(Blank password are permitted)

If a password is forgotten simply create a new password for the attendant.

Adding a Attendant

Crisis Controller—ATLAS System User Manual
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Attendants (continued)

This section indicates to the system what right the attend will have.

Admin

These attendants can only assign or de-assign HDT and print reports. All other functions are inac-cessible.

Operator attendants

These attendants can only do alarm monitoring. Operators can not stop Alarm Monitoring or exit the system. 
Under alarm monitoring mode there are access rights that can be assigned.

Supervisor attendants

Users set at this level have full access to all system options. They can start and stop Alarm Monitoring and do 
system configuration.

This section allows you to assign rights to Monitoring mode functions.

Toggle Groups

Allows the attendant to enable and disable Transmitter Groups and start and stop the Guard Tour option. 

Change Time Mode

Allows the attendant to change the Time Mode (Day, Evening and Night).

View Status Info

Checking this will allow the attendant to view the FPT Status Tab.

View System Messages

Checking this will allow the attendant to view the System Messages Tab.

View Tracking Info

Checking this will allow the attendant to view the HDT Status Tab.

Allow Simple Ack/Reset

Setting this option does not show the Action Taken/Notes window.

Role

Additional Permissions
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Attendants (continued)

Operators are individuals whose primary function is to monitor the ATLAS Alarm Monitoring Center. In the 
event of an alarm, Operators will access system information and monitor responses. Once logged in as an 
Operator, the monitoring screen cannot be minimized or exited by the Operator.

Operator-level personnel may be authorized to access various levels of information, as well as per-form several 
selective tasks. The degree of access is determined by options set by a Supervisor on the Adding a User or 
Editing an Attendant screen.

Primary Operator Tasks

Operators respond to information generated by the Crisis Controller software. Information about the system is 
displayed on the system monitor in Windows®-based information screens. Incoming alarm or trouble messages 
appear in the display with optional warning sounds, configured for each device.

Operators are responsible for acknowledging incoming alarms and determining that proper re-sponses are 
generated. This can include alarm verification and/or documentation of incoming data, depending upon the 
operating requirements of the Owner.

Operators

Crisis Controller—ATLAS System User Manual
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Attendants (continued)

Supervisors have access to all features. Supervisor-level personnel can access all menus. This permits them to 
configure the system and control user access levels and passwords.

Supervisory level access should only be granted to people who have been thoroughly trained  
on the system, as they have the capability of changing the operation and parameters    
of the system.

Primary Supervisor Tasks

Supervisors create and assign passwords to Operator and Admin users.

Programming Transmitters
Supervisors may add or delete Transmitters, Receivers, Repeaters, RF locators and any other hard-ware from the 
system.

Turning the system off
Only Supervisors with an Actall generated special user and password can exit the system once it has been 
activated.

Additional supervisory functions
System Supervisors have access to data that is not available to Operators or Administrative Users. For example, 
the Supervisor is authorized to access and modify account data information, and to review and modify 
information regarding system hardware.

Supervisors can import and edit site maps. Supervisors can set Transmitter programming, including how the 
system will respond to each Transmitter.

Supervisors should log out of the system before turning monitoring duties over to Operator or 
Admin level personnel.

System Configuration:

These menus include critical Supervisor responsibilities. Hardware and account information is man-aged through 
features used to configure the system. Supervisors may find it helpful to remember that most program functions 
of the Crisis Controller software are designed to present them first with a drop-down list of information. From 
the list, Supervisors may make selections that activate programming or data forms that can modify information 
in the list. This drop-down list architecture is followed in all features of the program, and is particularly pertinent 
to configuration tasks.

As a Supervisor, prior to exiting either the Alarm Monitoring Screen or the application, all   
alarms and troubles currently displayed should be acknowledged and reset. If this is not done,  
all current alarm information will be lost. In network versions of Crisis Controller, Supervisors   
may perform their duties on an Administration machine.

Supervisors
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Attendants (continued)

More on Logons

The Crisis Controller logon window allows you to change the current Attendant using the system.

File > Logon

In order to login to the Crisis Controller system you will need a user name and password. These are setup by 
attendants with Supervisor rights (see the tools section on page xxx)

To logon to the system choose tool > logon and the above screen will be shown. Enter in your atten-dant name 
and password. EXAMPLE:

NAME Operator
PASSWORD  1234

If a password or user name is forgotten a Supervisor attend will have to furnish you with a new 
password or tell you your logon name.

Crisis Controller—ATLAS System User Manual
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Stations

Adding/Changing a Stations

Devices 
The Device tab in Crisis Controller is reserved for creating and editing Stations, Data Servers and 
Gateways (MGEs). These devices form the primary interface between field devices (HDTs and LDNs) and 
the Crisis Controller software.

Upon startup, the information pre-configured onto your security key will display in the Station main screen. 
When configuring a Station, you must first select the appropriate station from the drop down list and enter the 
following information:

Property Code TAB: 

Pick a property code (1-32) to uniquely identify 
this system. The default value will be 1.   

Additional property codes can be added to this station 
from this screen. In addition, other property codes used 
on this site can be ig- nored for this station by checking 
the box under Options.

Devices > Stations
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Data Servers

Data Servers are used to aggregate and process location and alarm information transmitted from MGEs.

Devices > Data Servers

General TAB:

Name:         Name the Data Server (60 Char MAX. 
       Alpha Numeric and special characters 
       are OK)

Primary Station:      Select the Station that this Data Server 
       is  providing location information to.

Monitored MGEs:     All MGEs detected by this Data Server 
        will be displayed.

Server Settings TAB:

Adding/Changing Data Servers

Crisis Controller—ATLAS System User Manual
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Data Servers (continued)

Network TAB: 

Type in the IP address of the monitoring station. 
The IP address is pre- programmed from Actall and 
can be found in the system documentation 
accompanying your CPU. Alternatively, the IP address 
can be looked up using the ipconfig command in 
the Windows Command Line Utility.

When the appropriate entries have been entered correctly, click the OK box to close the window for this Station and 
the Close box to close the Main Station dialogue box.
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Data Servers (continued)

If this Data Server is to be used as the Primary Data Server (in multiple server configurations), check the ‘Enable’ 
box. If this is a configuration using only one Data Server, then this box should be checked.

On smaller installations that are installing the Data Server and running Crisis Controller on a single CPU, the ‘Use 
Host Monitor Station’ box should be checked. NOTE: Larger PALS Atlas installations will use separate pieces of 
hardware to process data and run Crisis Controller.

If a separate piece of hardware is used for the Data Server, the IP address (or DNS name) of the Data server must 
be entered in the IP/DNS box. The Port box is preconfigured as PORT 1024; other ports may be used.

If the Data Server being configured is used as a backup, then the Backup Server box should be checked. The same 
configuration instructions as used above should be changed for this selection.

Device Settings TAB:

The Check in interval for both HDTs and LDNs should be established here. The default value for both types of 
devices is 100 seconds, configurable in 10 second increments to a maximum of 2550 seconds. The LDN Buffer 
Window establishes the minimum times that LDNs will transmit back to MGEs. The default value is 1 second, 
configurable in one second increments up to 25.5 seconds.

Check intervals are used for supervision purposes and care should be taken not to over burden 
the RF capacity of the system. Please consult the technical support team at Actall for further  
information.

Crisis Controller—ATLAS System User Manual
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MGEs

MGE Templates are used to pre-populate configuration settings for MGEs. Information loaded to MGEs via the 
template menu can be individually altered for each MGE, if needed. Existing tem-plates will be displayed upon 
window launch, if no templates are displayed, click on the ADD button to enter new information.

Devices > MGE Templates

General TAB: 

When adding an MGE Template, the following 
settings must be entered:

Adding/Changing an MGE Template
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MGEs (continued)

Template Name: Select the name of the system to identify this Template.

Data Server:   Choose from the available Data Servers already configured.

PAN ID:  Unique Identifier for the RF devices deployed in this system.

RF Channel:   RF Channel (900 mHz) used for communication between devices in the system. 
Once deployed, all devices will renegotiate their chan- nel based upon   
their location and network availability.

Transmit Power: Default value for RF communication power. Do not change without
consulting Actall technical personnel.

Alarm Actions TAB: 

These values will be communicated to the 
filed devices when the devices con-nect to that MGE.

Person Down Delay:  This sets the delay that the PMT will experience (with warning tones) once a 
man down condition is experienced. The default value is 5 seconds, available 
values are 1—255 seconds.

Ping Interval: This value sets the interval that the PMT location radio will broad cast its ID for 
read by LDNs. The default value is 0.5 seconds, avail able values are 0.5 to  
25 seconds. 

Alarm Options: Reserved for future use.

Crisis Controller—ATLAS System User Manual
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MGEs (continued)

RF Settings TAB: 

This Tab sets the RF properties of the field 
deployed field devices.

LQI Threshold: Link Quality Indicator. This value sets the minimum strength at which an MGE will 
continue to connect to a field device. The de- fault value is 55; a range of values between 
1 and 255 is possible. A value of 75 or higher is recommended.

2400MHz: Select three channels for device communications on the 2400 MHz channel. These  
channels will need to modified in the MGE edit screens, based upon the results of the RF 
survey.

Broadcast Power: This value will set the signal strength for PMT communications on the 2.4 channel. The 
default value is 7, possible values can be 0— 15. The default value should not be 
changed unless recommended by the R F survey.

Discovering MGEs

Devices > Discovered MGEs
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MGEs (continued)

When the Discovering MGEs screen is launched, all Gateways reporting to this station will be displayed. Individual 
devices may then be edited by double clicking on the appropriate device.

Devices > MGEs

Add/Edit MGEs

Crisis Controller—ATLAS System User Manual
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MGEs (continued)

GENERAL TAB

Choose the appropriate MGE Template from the drop down menu.

IDENTITY Section

MAC Address: Repopulated from the chosen MGE.

ID:  Choose an ID Number for this device

Name:   Enter a Name for this Device

Data Server:  Choose the data Server used to gather data from this device.

PROGRAMMING Section:

PAN ID: Unique Identifier for the RF devices deployed in this system

RF Channel: RF Channel (900 mHz) used for communication between devices in the system. Once 
deployed, all devices will renegotiate their chan- nel based upon their location   
and network availability.

Transmit Power: Default value for RF communication power. Do not change without
consulting Actall technical personnel.

ALARM OPTIONS TAB
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MGEs (continued)

Person Down Delay: This sets the delay that the HDT will experience (with warning tones) once a 
man down condition is experienced. The default value is 5 seconds, available 
values are 1—255 seconds.

Ping Interval: This value sets the interval that the PMT location radio will broad cast its ID for 
read by LDNs. The default value is 0.5 seconds, avail able values are 0.5 to  
25 seconds.

Alarm Options: Reserved for future use.

RF SETTINGS TAB:

LQI Threshold: 

2400MHz: 

Broadcast Power: 

Link Quality Indicator. This value sets the minimum strength at which an MGE will 
continue to connect to a field device. The de- fault value is 55; a range of values 
between 1 and 255 is possible. A value of 75 or higher is recommended.

Select three channels for device communications on the 2400 MHz channel. These  
channels will need to modified in the MGE edit screens, based upon the results of the RF 
survey.

This value will set the signal strength for HDT communications on the 2.4 channel. The 
default value is 7, possible values can be 0— 15. The default value should not be 
changed unless recommended by the R F survey.

Crisis Controller—ATLAS System User Manual
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The Pager Service contains information regarding the Pager Transmitter and the pagers associated with the pager 
transmitter.

Devices > Pager Services

When adding a pager service the following settings must be entered:

Name: Select the name of the system 
to identify this hardware 
(i.e. Actall Page Alert).

Model: The make of the Page Transmitter.

Station: Select the station to which the 
PageTransmitter is physically  
connected. Stations 
can be viewed the in the drop  
down list

Port: The COM port to which the Page 
Trans mitter is attached.

Pager Services

Adding/Changing A Pager Service
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Pager Services (continued)

Pagers (typically identified by the user assigned to the pager) are programmed into the Crisis Con-troller® software. 
They can then be assigned to specific Transmitter areas, and/or can receive pages sent manually through the Crisis 
Controller® software. Prior to assigning a pager, each individual pager must first be defined.

Name: Enter the name to be assigned to the pager. (ex: Group Page)

Number: The Cap-Code of the pager (the Cap Code is generally displayed when the pager is 
turned on).

Baud Rate: Choose between 512, 1200 and 2400, in accordance to the hardware being used.

Adding/Changing a Pager

Crisis Controller—ATLAS System User Manual
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Intercom Systems open audio paths between the main station and the sub-station to allow for communication.

Devices > Intercom Systems

When Adding in an intercom system the following is required.

Name: Assign a name for the   
system to identify this 
hardware (i.e. Stento 9600 
control).

Model: Type of intercom being   
used. (chosen form drop 
down list)

Station: Select the station that   
physically has the intercom 
system attached. Stations  
can be viewed in drop 
down list.

Port: COM port to which 
the intercom system is 
connected.

Adding/Editing an Intercom System

Intercom Systems
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Intercom Systems (continued)

Adding/Editing an Intercom System
Devices > Intercom Systems >Add (or Edit) > Add (or Edit)

Intercom Stations are physical channels on the Intercom System.

When Adding in an intercom stations the following is required:

Name:   Assign a name for the system to identify this hardware (i.e. kitchen intercom).

Number: Relay number on relay card.

Test Button: Stations may be tested after they are entered. To test a pager select the pager form the 
list and press the test button.

Intercom stations can be associated with alarms from fixed point locations or LDN locations. 
The soft-ware automatically switches intercom connections when new alarms occur. The Crisis 
Controller soft-ware refreshes this connection periodically (in case the intercom connection is  
manually changed).

Crisis Controller—ATLAS System User Manual
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Contact Inputs/Outputs

Adding/Changing A Relay Card

Devices > Relay Cards > Edit

The SIO32 module is a multi-functional relay board that will permit system installers to activate up to 32 output 
devices or allow up to 32 inputs, or any combination of inputs and outputs in groups (“banks”) of 8. When Adding 
a relay Card the following information is required:

Name: Assign a name for the system to identify this hardware (i.e. SIO32 board #1)

Model: Type of relay board

Station: Select the Monitoring Station that physically attached to the Relay Board. Stations are 
selected from the drop down list.

Port:   Identify the Com port to which the relay board is connected.

Board Number: The Board Number (1-8) is designated by the DIP switch settings on the SIO32 board.

Banks must be designated as either input or output using the DIP switches on the 
SIO32 board. [See Actall® Installation Manual for DIP switch configuration.]



28

Contact Inputs/Outputs (continued)

Adding Relays

Adding Inputs

Devices > Relay Cards > Add > Add

Relays are contact closures that are normally open or normally closed, depending on how the relay is wired. When 
adding a relay the following information is required:

Name: Assign a name for the system to identify this relay.

Number: Relay to be activated on the SIO32 board.

Duration: The action of the relay. The four options are as follows:

* Until Acknowledge—Set relay until associated alarm is acknowledged.
* Until Reset — Set relay until associated alarm is reset.
* Momentary — Relay is set for short duration (less then 3 seconds)
* Toggle— Relay state is changed.

Test Button: Relays may be tested by selecting the relay from the list and pressing the test but-ton. 
The relay will momentarily change states.

Inputs are dry contacts on the SIO32 relay/input board that can be normally open or closed. The first step to 
creating an input for the SIO32 relay/input board is to create profiles for the inputs. Profiles determine the action to 
be taken when an alarm condition is matched. Profiles allow global changes to input actions to all inputs assigned 
to the profile.

Crisis Controller—ATLAS System User Manual
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Adding/Changing a Profile

Devices > Input Profiles > Add (or Edit)

General TAB:

The following options are available on the
General Tab:

Name: The name to identify the 
input profile (input may
 use the same profile).

Page on Alarm: When the alarm is received 
send a page to the chosen  
pager.

Page on Acknowledge: When the alarm is acknowledged send a page to the chosen pager.

Page on Reset:   When the alarm is acknowledged send a page to the chosen pager.

Sound on Alarm: When the alarm is received play the chosen sound file.

Sound Continually: When the alarm is received continue to play the chosen sound file until the 
ac-knowledged button is pressed.
-Note: If this option is not selected the sound file will play only once.

Auto Acknowledge: When the alarm is received the system will automatically acknowledge and 
re-set the alarm after thirty seconds.

Sound File Name: The sound file that will play when this alarm is received. Use the browse 
button to select the file to be played on alarm. (Horn.wav is the default 
sound file)

Contact Inputs/Outputs (continued)
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Contact Inputs/Outputs (continued)

Time Mode Tab:

This Action Tab contains the settings that determine the 
time mode to receive alarms. The three options are Day, 
Evening, and Night.

Pager Tab:

This tab determines what pagers are to receive a message 
when an alarm is received. To select pagers for to be 
included press the Edit button and a list of pagers will be 
displayed. Select each pager to receive messages for the 
profile. Once the OK button is pressed, the selected pagers 
will appear in the Alarm Profile Pagers box.

Crisis Controller—ATLAS System User Manual
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Heavy Duty Tags (ATLAS)

An ATLAS Heavy Duty Tag (HDT) is a RF based unit used to locate an individual in a duress situation. The HDT 
broadcasts its ID# and that number is sent back to Crisis Controller via the appropriate LDNs and MGEs. When 
the HDT goes into alarm, The alarm information is sent di-rectly to the MGEs via 900MHz and the location is 
resolved within Crisis Controller and displayed on the User Interface.

HDT profiles and templates and these items must be defined before configuring a HDT.

The options available in a profile determine how the software will respond when an alarm is re-ceived 
transmitter. Profiles also allow global changes to the options to all HDTs assigned to the pro-file.

HDT >Alarm Profiles

Add Button   To add a new profile.

Edit Button   To edit an existing profile. Highlight the profile and press the Edit button

Delete Button To delete a profile from the system.

If the profile is being used by any transmitter the profile can not be deleted.

Defining a HDT Alarm Profile
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Heavy Duty Tags (ATLAS) (continued)

The General Tab:

When adding a Profile the following information is required:

Name:   

Page on Alarm: 

The name to identify the profile (Different HDTs may use the same profile) 

When the alarm is received send a page to the chosen pager.

Page on Acknowledge:  When this alarm is acknowledged send a page to the chosen pager.

Page on Reset:  When the alarm is acknowledged send a page to the chosen pager.

Sound on Alarm: When the alarm is received play the chosen sound file.

Sound Continuously: When the alarm is received continue to play the chosen sound file until the acknowledged 
button is pressed. Note: If this option is not selected the sound file will play only once.

Auto Acknowledge: When the alarm is received the system will automatically acknowledge and reset the 
alarm after thirty seconds.
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Heavy Duty Tags (ATLAS) (continued)

The Time Mode Tab:

This tab determines which time periods will receive and display alarms. (Day, Evening, Night)

The Sounds Tab:

This tab allows the user to select different alarm sounds for different alarm conditions.
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Heavy Duty Tags (ATLAS) (continued)

HDT> Templates

Add Button   To add a new template to the system.

Edit Button   To Edit the selected template.

Delete Button To delete a template from the system.

Defining a HDT Template
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Heavy Duty Tags (ATLAS) (continued)

When adding a Template the following information is required:

Name:   

PAN ID:  

Property Code: 

The name of the template (ex: HDT General Template1).

Leave blank for the template or assign to a factious name. (Ex: -Default Name).

Identifies the receiver that will be monitoring the HDT and also assigns the HDT it’s  
property code. 
When multiple receivers are used in the system, select the desired re-ceiver from the 
drop down list. (For more information on property codes see the re-ceiver section).

If the person down delay specified in the MGE template setup is satisfactory for this template, check this box. 
If you would like a different setting for this template, leave this box unchecked and set the desired value in the 
available drop down menu.
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Heavy Duty Tags (ATLAS) (continued)

Alarm Actions Tab

The operating parameters of the PMT are set 
on this tab.

This section contains which alarms the PMT should transmit. If an alarm is disabled (not checked) the HDT will not 
transmit that alarm.

Panic Button: When checked, the HDT will send a panic alarm when the panic button is pressed. If 
unchecked the HDT will not transmit the Panic alarm.

Pull Cord:  When checked, the HDT will send a Pull Cord alarm when pull cord is removed. If 
un-checked the PMT will not transmit the Pullcord alarm. 

Person Down: 

Tamper: 

When checked, the HDT will send a Person Down alarm when its is tilted more than 60 
degrees for the set time period. If Unchecked the HDT will not transmit the 
Person Down alarm.

For future use.

Alarm Options Section
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Heavy Duty Tags (ATLAS)(continued)

This Section allows you to configure the supervision interval and miscellaneous options.

Supervision Interval: This parameter sets the period that Crisis Controller will listen for a transmission from the 
HDT before setting an alarm condition.

Chirp on Alarm: Checking this box will cause the HDT to sound an audible tone when an alarm condition is set on 
the device.

Other Options Section
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Heavy Duty Tags (ATLAS) (continued)

All PMTs use Profile and Templates these must be defined before entering any 
HDTs into the system.

HDT > HDTs

HDTs previously programmed into the software will display when this screen is launched. The Programmed? 
Column will indicate the programming status of each device.

Red X 

Blue Check 

Add Button: 

Edit Button: 

Delete Button:   

Program Button: 

HDT is not programmed with current settings in system.

HDT is programmed with current settings in system.

To create a new HDT

To edit the configuration of an existing HDT. (Note: Some HDT information changes will 
result in a Red X being display next to the HDT in the list. This Red X indicates that the  
HDT requires reprogramming.)

To delete the selected HDT from the system.

After all configuration settings for the HDT are entered into the system, the Program 
button is used to program the data into the HDT.

Add/Edit a HDT
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Heavy Duty Tags (ATLAS) (continued)

The General Tab:

 A template is not required to be used
but the correct alarm profile must be 
chosen on the action tab.

When entering in HDT transmitters, the following information can be entered manually (or filled utilizing 
a template):

HDT Template: 

Serial Number: 

ID:  

Assigned to: 

PAN ID:  

Property Code: 

Choose the appropriate template for this tag. No template is needed.

This field can not be edited. This field is used for the bar-coding function.

This number is generated by the system. The ID number may be changed if necessary  
the Serial Number field will change accordingly. Duplicate IDs are not allowed by the  
system.

The name of the user for this tag. This field will not populate until persons are entered.

Unique Identifier for the RF devices deployed in this system.

Pick a property code (1-32) to uniquely identify this system. This should match the 
Station Property Code selected earlier.

If the person down delay specified in the MGE template setup is satisfactory for this template, check this box. 
If you would like a different setting for this template, leave this box unchecked and set the desired value in the 
available drop down menu.
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Heavy Duty Tags (ATLAS) (continued)

The Alarm Actions Tab:

This section contains which alarms the PMT should transmit. If an alarm is disabled (not checked) the HDT will not 
transmit that alarm.

Panic Button: If checked the HDT will send a panic alarm when the panic button is pressed. If un-checked the HDT 
will not send this alarm.

Pull Cord: If checked the HDT will send a Pull Cord alarm when the pull cord is removed. If un-checked the HDT 
will not send this alarm.

Person Down: If checked the HDT will send a Person Down alarm when the HDT is tilted more than 60 degrees for 
the set time period. If Unchecked the HDT will not send this alarm.

This Section allows you to configure the supervision interval and miscellaneous options.

Supervision Interval: This parameter sets the period that Crisis Controller will listen for a transmis-sion from 
the HDT before setting an alarm condition.

Chirp on Alarm: Checking this box will cause the HDT to sound an audible tone when an alarm con-dition is set on 
the device.

Alarm Options Section

Other Options Section
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ROUND TAG PROGRAMMING

A Round Tag is a RF based unit used to locate an individual in a duress situation. The Round Tag broadcasts its 
ID# and that number is sent back to Crisis Controller via the appropriate LDNs and MGEs. When the Round Tag 
goes into alarm, The alarm bit is set in the data string to the LDNs and the location is resolved within Crisis 
Controller and displayed on the User Interface.

Round Tag profiles and templates and these items must be 
defined before configuring a Round Tag

The options available in a profile determine how the software will respond when an alarm is received tag. Profiles 
also allow global changes to the options to all Round Tags assigned to the profile.

Round Tag >Alarm Profiles

Add Button   

Edit Button   

Delete Button 

To add a new profile.

To edit an existing profile. Highlight the profile and press the Edit button

To delete a profile from the system.

If the profile is being used by any tag the profile can not be deleted.

One and Two Button Round Tags

Defining a Round Tag Alarm ProfilE
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ROUND TAG PROGRAMMING (continued)

The General Tab:

When adding a Profile the following information is required:

Name:   The name to identify the profile (Different Crickets may use the same profile).

Page on Alarm: When the alarm is received send a page to the chosen pager.

Page on Acknowledge:  When this alarm is acknowledged send a page to the chosen pager.

Page on Reset:  When the alarm is acknowledged send a page to the chosen pager.

Sound on Alarm:  When the alarm is received play the chosen sound file.

Sound Continuously: When the alarm is received continue to play the chosen sound file until the 
acknowledged button is pressed. Note: If this option is not selected the sound file will
 play only once.

Auto Acknowledge: When the alarm is received the system will automatically acknowledge and reset the 
alarm after thirty seconds.
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ROUND TAG PROGRAMMING (continued)

The Time Mode Tab:

This tab determines which time periods will receive and display alarms. (Day, Evening, Night)

The Sounds Tab:

This tab allows the user to select different alarm sounds for different alarm conditions.
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ROUND TAG PROGRAMMING (continued)

Templates are used as a shortcut to add in transmitter information that is common to the Round Tags that are 
being added into the system. The template contains information on the way the transmitter is to be 
programmed; Name, Contact Type, Check-in Interval, Supervision Interval, Default Receiver, any relays, intercom 
stations and or cameras to be activated by an alarm. Templates also contain an Alarm Profile to use (see Round 
Tag  Alarm Profile section for more information).

Round Tags> Templates

Add Button   To add a new template to the system.

Edit Button   To Edit the selected template.

Delete Button To delete a template from the system.

Defining a Round Tag Template
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ROUND TAG PROGRAMMING (continued)

When adding a Template the following information is required:

Name: The name of the template (ex: Round Tag General Template1)

Supervision Interval:  User defined setting showing how often CC should check for a transmission from this 

Property Code: 

Round Tag.

Identifies the receiver that will be monitoring the Round Tag and also assigns the 
Round Tag it’s property code. When multiple receivers are used in the system, select 
the desired receiver from the drop down list. (For more information on property 
codes see the  receiver section).
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ROUND TAG PROGRAMMING (continued)

All Round Tags use Profile and Templates these must be defined before entering any 
Round Tags into the system.

Round Tags > Round Tags

Crickets previously programmed into the software will display when this screen is launched.

Add Button 

Edit Button 

Delete Button 

To create a new  Round Tag.

To edit the configuration of an existing Round Tag. (Note: Some tag information 
changes will result in a Red X being display next to the Round Tag in the list. This Red X 
indicates that the  Round Tag requires reprogramming.)

To delete the selected Round Tag from the system.

Add/Edit a Cricket
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ROUND TAG PROGRAMMING (continued)

The General Tab:

A template is not required to be used but the correct alarm profile must be chosen on 
the action tab.

When entering in Round Tag transmitters, the following information can be entered manually (or filled 
utilizing a template):

Choose the appropriate template for this transmitter. No template is needed.

This field can not be edited. This field is used for the bar-coding function.

This number is generated by the system. The ID number may be changed if necessary 
the Serial Number field will change accordingly. Duplicate IDs are not allowed by the  
system.

 The name of the user for this transmitter. This field will not populate until persons are 
entered.

Round Tag 

Template: Serial 

Number:   ID:  

Assigned to: 

Alarm Profile: Choose the appropriate Alarm Profile from previous entries.

Supervision Interval: Choose the desired interval that you want CC to check for a transmission from this device..
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LDNs

Defining an LDN Alarm Profile

Location Device Nodes (LDNs) are RF devices located throughout your facility that listen for HDTs and 
provide location information to MGEs.

The options available in a profile determine how the software will respond when an alarm is re-ceived transmitter. 
Profiles also allow global changes to the options to all PMTs assigned to the pro-file.

HDT >LDN Profiles

Add Button   To add a new profile.

Edit Button   To edit an existing profile. Highlight the profile and press the Edit button

Delete Button To delete a profile from the system.

If the profile is being used by any transmitter the profile can not be deleted.
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LDNs (continued)

The General Tab:

When adding a Profile the following information is required:

Name:   The name to identify the profile (Different PMTs may use the same profile)

Page on Alarm: When the alarm is received send a page to the chosen pager.

Page on Acknowledge:  When this alarm is acknowledged send a page to the chosen pager.

Page on Reset:  When the alarm is acknowledged send a page to the chosen pager.

Sound on Alarm: When the alarm is received play the chosen sound file.

Sound Continuously: When the alarm is received continue to play the chosen sound file until the 
acknowledged button is pressed. 
Note: If this option is not selected the sound file will play only once.

Auto Acknowledge: When the alarm is received the system will automatically acknowledge and reset the 
alarm after thirty seconds.
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LDNs (continued)

The Time Mode Tab:

This tab determines which time periods will receive and display alarms. (Day, Evening, Night)

The Sounds Tab:

This tab allows the user to select different alarm sounds for different alarm conditions.
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LDNs (continued)

Templates are used as a shortcut to add in transmitter information that is common to the LDNs that are being 
added into the system.

HDT> LDN Templates

Add button   To add a new template to the system.

Edit Button   To Edit the selected template.

Delete Button To delete a template from the listing.

Defining an LDN Template
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LDNs (continued)

The General Tab:

When adding a Template the following information is required:

Name:   

LDN Transition Section

Low Transition Threshold:  

High Transition Threshold:  

The name of the template (ex: LDN General Template1)

RF strength setting below which HDT location pings will be ignored.

RF strength setting above which HDT location pings gives the highest 
confidence that the HDT is underneath the LDN sensor.

Notes Section:
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LDNs (continued)

Alarm Actions Tab:

The operating parameters of the LDN 
are set on this tab.

This section contains features specific to LDNs

Is Entry/Exit:   Check this box if this location device is an entry or exit device to an outdoor zone.

No Supervision : Check this box if you want Crisis Controller to ignore supervision time.

Ignore Alarms:   Check this box if the device is being used a test device.

Localized Alarm Options

Supervision Interval: Set the time interval that devices under this profile should be monitored.

Tamper:  For future use.

Localized Alarm Options
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LDNs (continued)

Alarm Options Tab:

ADD Pager:

Click EDIT to open up a list of pagers already entered into the system.

DELETE Pager:

Click on the pager that you want to delete, then click DELETE to delete that pager.
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LDNs (continued)

HDT > LDNs

LDNs previously programmed into the software will display when this screen is launched. The Programmed? 
Column will indicate the programming status of each device.

No  LDN is not programmed with current settings in system.

Yes LDN is programmed with current settings in system.

Add Button To create a new LDN.

Edit Button To edit the configuration of an existing LDN. Delete Button To delete the se lected LDN 
from the system.

Program Button After all configuration settings for the LDN are entered into the system, the Program 
button is used to program the data into the LDN.

Add/Edit an LDN
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LDNs (continued)

The General Tab:

A template is not required to be used but the correct alarm profile must be chosen on the action tab.

When entering in LDNs, the following information can be entered manually (or filled utilizing a template):

ID: 

PAN ID: 

Location: 

Choose an appropriate ID number for the device.

This field can not be edited. This field is used for the bar-coding function.

Enter a description of the device that will aid in location of the HDT. This field is limited to 80 
Alpha Numeric characters, but care should be take to try and truncate this down to a size that 
will display properly in the Alarm window.
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LDNs (continued)

The Configuration Tab:

Low Transition Threshold:  

High Transition Threshold: 

RF strength setting below which HDT location pings will be ignored.

RF strength setting above which HDT location pings gives the highest 
confidence that the PMT is underneath the LDN sensor.

Linked LDN Section

This section identifies the physically adjacent LDNs to the device that you are editing. Adding a de-vice can be done 
by Clicking ADD and finding the adjacent LDN from a list, or simply by entering the number of the LDN in the ID 
box above the list.

Ignored LDN Section

This section identifies the LDNs that are to be ignored by the Data Server if location ping from a HDT is heard 
after location is determined at this LDN.
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LDNs (continued)

Alarm Actions Tab:

The operating parameters of the LDN are set on 
this tab.

This section contains features specific to LDNs

Is Entry/Exit: Check this box if this location device is an entry or exit device to an outdoor zone.

No Supervision: Check this box if you want Crisis Controller to ignore supervision parame ters.
Ignore Alarms Check this box if the device is being used a test device.

Localized Alarm Options

Supervision Interval: Set the time interval that devices under this profile should be monitored.

Tamper:  For future use.

Localized Alarm Options
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LDNs (continued)

Alarm Options Tab:

LDN Transmissions to external pagers are specified 
on this tab.

Click EDIT to open up a list of pagers already entered into the system.

DELETE Pager/Intercom/Relay Output:

Click on the pager that you want to delete, then click DELETE to delete that pager.

ADD Pager/Intercom/Relay Output:
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Entering People

This menu contains a list of the people that will carry mobile transmitters being used in your system. People can 
be directly associated with transmitters to display their name when an alarm is activated and to display 
additional information about the HDT User to the Control Operator.

HDT > People

Add Button   Use this button to add a new person.

Edit Button   Used this button to edit information about the selected person.

Delete Button Use this button to delete the selected person from the system.

Close Button  Use this button to close the window.
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Entering People (continued)

The following information is required when adding people into the system:

Code/ID: This is a unique alpha-numeric number/id for each person being added. Employee id 
(ex: 12345)

Name: Name of the person being added. The Following fields are optional
Address, City, State, Zip, Phone

Photo Button: A photo may be added for better identification of the person.
Press the photo button to added the desired photo the persons in formation.

Visitor Check box: This box is here to allow you to quickly identify if this person is a employee or a visitor to 
your facility.

Note Tab: Use this space to enter any relative information about this person.
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Guard Routes

The Guard Route feature of the Crisis Controller® software permits users to designate timed patrol 
circuits. Personnel carrying specially assigned HDTs are monitored by the system as they cover a precise course. 
The system tracks the order of the LDNs which are reported and monitor the time interval between stations. 
Delays from the allotted time between stations or from the route pre-scribed causes an alarm. A Guard Route is 
defined by listing a sequence of locations.

HDT > Guard Routes

Add Button   Use this button to add in a new guard route to the system.

Edit Button   Use this button to edit the selected guard route.

Delete Button Use this button to delete the selected guard route from the system.
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Guard Routes (continued)

When creating a guard route the following information is required:

Name: This identifies the guard route to the user and the system.

Route Type: Crisis Controller offers three different types of Guard Routes. Type A (Timed Locations)  
constructs a route that consists of two or more points, each of which must be reached in 
a certain order and within a certain time frame. Type B (Entry/Exit) creates a timed route 
be tween two locations that can require passing other locations in any order prior to  
finishing. Type C (Scheduled Locations) sets a tour that specifies a arriving at specific
 spots  at specific times.

Routes: A summary of the information input from above.
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Maps

The Maps option is one of the most useful features in the Crisis Controller software. When a par-ticular device 
is being activated, alarm center personnel can see the location of the alarm on a map of the site. The sub-map 
capability permits users to “zoom” in on sites in increasing detail. For ex-ample, an initial alarm can be programmed 
to indicate a building from which the alarm originated. A user can click on the map to get a detailed map of the 
interior of the building, and click again to get details of particular areas.

Maps are prepared in drawing programs which can export .BMP or .JPG files. Windows® Paint pro-gram is available 
to most Windows® users and creates .BMP files.

Tools > Maps

Layout Button Use this button to add or edit the LDN and MGE Layouts

Add Button   Use this button to add a new map to the system.

Edit Button   Use this button to Edit the selected maps file name and path.

Delete Button  Use this button to delete the selected map from the system.
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Maps (continued)

When Adding maps to the system the following information is required:

The first map added to the system is the fist map that is displayed (i.e.: overview map 
or sitemap)

Name: This identifies the map to the system and the users.

Path: This is the path to

The Add/Edit buttons
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Maps (continued)

Map: Use this Drop Down box to select different map to edit.

Group: Use this Drop Down box to change the type of device to add to the map (LDN, MGE, 
Relay Input, IRT locator or Sub map)

Items: Use this Drop Down box to select the desired device to be added.

Items that have been added to the map will no longer appear in the “Items” drop 
down box.

Add Button Use this button to add the device shown in the “Items” box to the map. The Icon that  
represents this device will appear in the upper left hand corner of the map (0,0) with the 
default icon size. To move icons simply click and drag the icon to the desired location.

Delete Button Use this button to delete the selected icon form the map. Deleted device will   
appear back in the “Items” drop down list when the cor rect device group is selected.

World Buttons Use these button to move all icons on the map up, down, right or left.

Map Layout Button
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Maps (continued)

Zoom Use the zoom drop down list to change the viewing size of the current map 
(only affective in map layout).

(+ -) Button Use these button to change the size of the selected icon.

To exit Map Layout click the X in the upper right hand corner.

Sub map icons permit the displaying of an additional map which can show greater detail. It is recommended 
before placing sub-maps, a particular area on the map is marked graphically that will represent the link to a sub-
map. It is also recommended that sub-maps have an area marked for a link back to the main map, otherwise you 
will be unable to return to the main map from a sub-map.

When in alarm monitoring mode only the sub map link that has the current alarm 
location represented on the sub map will be activated. This allows sub maps to overlay 
each other.

Sub maps (explained)
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Options/Settings

The Options Menu allows you to configure settings that control how Crisis Controller functions.

Tools > Options

The General Tab:

Day Mode Start Time:  The time Day Mode will start.

Evening Mode Start Time: The time Evening Mode will start.

Night Mode Start Time:  The time Night Mode will start.

If Auto Start box is unchecked for any time mode, then the Attendant will have to manually start that time mode.

Page on Low Battery:   If checked the system will tell the pager to send a page when the low   

Page from Test LDN:  

Relay Alarm Tracking: 

battery alarm is received. The pager that is paged will be the one 
associated with the (for HDTs the IR location) (FPT will page the pager in 
it’s associated profile).

This allows for page transmission from LDNs designated as test devices.

If this is checked when a PMT changes location any relays that are 
associated with the new location will be activated.
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Options/Settings (continued)

The Network Tab:

This Tab allows you to configure each system to send
and receiver network data. The settings con-figured 
under this tab are local to the system that the configuration 
is preformed on.

Inbound

Receive Data:   Allows Crisis Controller to receive alarm information over the net-work.

Receive Acknowledge: Allows Crisis Controller to receive alarm Acknowledges over the network.

Receive Reset:   Allows Crisis Controller to receive alarm resets over the network.

Outbound

Send Data:  Allows Crisis Controller to send alarm information over the net-work.

Send Acknowledge: Allows Crisis Controller to send alarm Acknowledges over the net-work.

Send Reset:  Allows Crisis Controller to send alarm resets over the network.
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Options/Settings (continued)

The Options Menu allows you to configure settings that control how Crisis Controller 
functions.

The Alarm Processing Tab:

PMT Alarm Options
Panic:  
Pullcord: 
Person Down:   

If unchecked the system will ignore all Panic alarms from HDT tags.
If unchecked the system will ignore all Pullcord alarms from HDT tags.
If unchecked the system will ignore all Person Down alarms from HDT tags.

FPT Alarm Options
Disabled for future use.

LDN Alarm Options
Disabled for future use.

MGE Alarm Options
Disabled for future use.

MGE Alarm Sound
Choose the desired audible sound for MGE alarms.
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Options/Settings (continued)

The Printer Output Tab:

The tab lets you configure alarm information to 
be outputted to a dot matrix printer and or a serial 
port. 

Log to Printer Box  If this box is checked all alarm information will be sent to the printer
 on the chosen port.

Printer Port:   The physical port the printer is connected to.

Lines per Page:   The number of line per page for your printer (default is 66).

Printer Initialization Codes: This box is provide to send any required codes to your printer. (most printer by 
default do not use any codes)

Serial I/O

Send Serial I/O Box: If this box is checked the system will send alarm data out the cho-sen serial port.

Serial I/O Port:   This is the serial port the data will be sent to.

For more information on serial I/O contact Actall Corp.
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Options/Settings (continued)

The Location Logging Tab:

This tab allows you to enable or disable location 
logging of HDTs. The settings configured under this tab 
are local to the system that the configuration is
 preformed on.

Do Logging Box: Check this box to start location logging.

Directory:  The directory (folder) that the data is logged to. (The folder must exist in order to be used)
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Alarm Monitoring

When alarm monitoring is started the Crisis Controller system will now receive alarms from transmitters and 
execute the programmed repose for the alarm received. Depending on attendant type (Operator or Supervisor) 
and permissions set for the attendant more tabs and monitoring options are available. To start alarm monitoring 
mode go to the main menu and chose Monitoring > Start the following screen will be shown.

Under this tab will be displayed any alarms received by the Crisis Controller system. When alarm are received 
select the desired alarm from the list. The selected alarm can display in two colors:

1) RED The current alarm has not be acknowledged by the attendant.

2) YELLOW The current alarm has be reset by an attendant.

Acknowledge Button
Use this button to acknowledge the selected alarm that have be received.

Reset Button
Use this button to reset the selected alarm.

Alarm Status Tab
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Alarm Monitoring (continued)

While monitoring there are several options available for the attendant to help in the processing of alarms.

Stop:   Stop Alarm Monitoring Mode.

Layout:  Allows the user to change the view of the monitoring screen.

Time Mode:  Activate or deactivate a time Mode.

Send Page:  Send a page to a pager.

FPT Groups:  Activate or deactivate a FPT group.

Guard Routes: Activate a Guard Route.

The Monitoring Menu Option
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Alarm Monitoring (continued)

Date/Time: 

Name: 

Location: 

Reason: 

Status: 

ID: 

Restored: 

Displays the date and time the selected alarm was received.

The name associated with the tag. If the tag is a FPT this field is the static text entered 
into the name field of the FPT. If the tag is a mobile FPT,PALS 9000  or a L2L this is the 
assigned name for this tag.

The current location of the selected tag.

This is the type of alarm form the tag. FPT tags can display Alarm, Tamper or Inactive. 
ATLAS or L2L can display Panic, Pull-cord, Person down or Inactive.

This show if the selected tag has been Acknowledged and Reset by the attendant. 

Displays the tag programmed ID number.

Displays if the tag has returned to its normal state (True or False). If the alarm remains 
after being reset check this field for the reason of the no-reset.

Example: After and Pull Cord alarm has been received for an ATLAS tag. The attendant can  
acknowledged and reset but the alarm remains displayed in the alarm status window. The cause 
could be that the pull cord break has not been reinserted into the tag. The alarm will remain on the 
display until the tag has been returned to its normal state, after doing so the tag will transmit a OK 
signal which Crisis Controller will receive and then clear the alarm.

Alarm Status window headings
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Alarm Monitoring (continued)

The Crisis Controller software allows the user to set the monitoring screen with different screen views. These 
layout choices are standard within Crisis Controller and allow the Attendant to switch between Horizontal and 
vertical views, eliminate maps, Change font size and display characteristics. The standard layout is divided into 
textual display of alarms and a mapping area. Each of these ar-eas can be undocked from the standard display and 
enlarged, as needed. To change the different configurations the system will need to be in Monitoring mode. Once 
in monitoring mode click on Monitor and move down to Layout, as seen below.

The preview pane will show you what the 
configuration will look like after clicking on 
the Accept

Monitoring Screen Layout

Crisis Controller—ATLAS System User Manual
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Alarm Monitoring (continued)

When a Supervision alarm comes in, the Operator needs to Acknowledge and then Reset the alarm. The 
Supervision alarm will then move to the Queue window, clearing the main screen to allow for duress 
alarms to show up.

Alarm Monitoring
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Alarm Monitoring (continued)

After clicking on the Acknowledge button the Status will change to Acknowl-edged as shown above. Now 
the Operator needs to click on the Rest button. After doing so, this Supervision alarm will move to the 
Queue window as seen below.

In this example, the HDT was taken off property and can’t send in Check-In messages. This alarm will 
stay in the Queue until the HDT is brought back to the facility. Once the devices checks in, the alarm will 
clear from the Queue window.

Alarm Monitoring

Crisis Controller—ATLAS System User Manual
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Alarm Monitoring (continued)

List View 

In the example to the right, a Wall 
transmitter alarm was received. 
The name of the transmitter and 
it’s location are shown in red and 
also show up on the map in the 
bottom left corner. The alarm is 
wait-ing to be acknowledged and 
reset.

Panel View 

In the example to the right, we 
clicked on Panel view to change 
the way the alarm is viewed in the 
Alarm window. Again, the alarm 
is also shown on the map at the 
bottom left.

Alarm Monitoring
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Alarm Monitoring (continued)

After acknowledging and alarm, the box be-ow 
will appear. This box will appear if Simple Ack and 
Reset are NOT checked in the Opera-tors settings in 
Attendants (see page 8-10).

After clicking OK on the Alarm Log box, the screen 
will then show the alarm ICON in Yellow. This means 
that the alarm is waiting for the operator to re-et 
it after hearing that the situation has been handled.

Acknowledging and Resetting Alarms

Crisis Controller—ATLAS System User Manual
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Alarm Monitoring (continued)

The operator can now select a pre-programmed response or can manually type in a summation for the 
event. These log entries will appear in the reports with a time and date stamp attached to them. Once 
reset, the alarm screen will clear.

Resetting an Alarm
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